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Frequency coordination is a process.  Follow the steps and it’s 
easy.   
 
The need for coordination is because the wireless mics, ears and 
guitar transmitters mostly operate in the UHF TV bands – which 
are currently channel 14 to 51 in the USA and 21 to 59 in 
Europe.  Every location has different channels actually in use 
and it is imperative to avoid picking frequencies, which are on or near these TV stations.  
First of all it’s illegal to interfere with the TV broadcast (which really doesn’t happen 
because they are so much more powerful than your puny wireless mic) and more 
importantly, the mic won’t work well for you. You could however interfere with a nearby 
television set attempting to receive a distant over the air station.  This should be avoided. 
 
Often you can get by just setting your systems to any clear frequency which is separated 
from all your other wireless and the TV stations.  Typically a user will just turn on their 
receiver, see if it’s on a clear channel (no RF showing on the meter) and then set their 
transmitter on that freq. 
 
However the process listed here will give a better result in the end.  This manual uses 
these tools: 
 

1. The software program by Professional Wireless 
is called Intermodulation Analysis System which 
costs $550.00.  The software has a database of 
most wireless equipment and their frequency 
bands.  It calculates the frequencies based on 
avoiding intermodulation products. The icon 
says IMD even though the program name says IAS.  In this manual we will 
call it IMD. 
  
A good white paper on the basics of intermodulation interference and simple 
calculations was written by James Web from NASA, “What is 
Intermodulation Interference” 
 

2. Rhode & Schwartz FSH3 Spectrum analyzer costs about 
$7,000.00 in it’s basic configuration.  It’s better to get it 
with a built in preamp and a tracking generator for RF 
tests and adjustments (the model .23) 
 

An inexpensive Spectrum analyzer is 
the TTI PSA Series2  for about 
$1400.00. 
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3. The "CHANNEL GUIDE" which is FREE is a basic frequency and channel 
reference.  Listed on the page are many manufacturers and their programmed 
standard groups.  Your scans from the local venue can be entered and you can 
easily see what RF bands are affected. 

 
 

 
 

I. Basic steps – create the basic file: 
A. Scan venue for TV stations in use 
B. Enter as generic, in a separate ZONE, other nearby wireless mic/com/IEM 

transmitters 
C. Select equipment freqs in IMD software 
D. Label frequencies with function names 
E. Examine each freq closely for interference on the SA 
F. Program Ear transmitters and walk test – adjust if it doesn’t work. 
G. Program Intercom Base TX and walk test. 
H. Program Intercom Beltpacks RX, Mics and Guitar systems. 
I. Review each freq while all are turned on – kill each TX one at a time and look 

underneath for intermod peaks.  This is called war gaming. 
 

II. Repeat shows in a different venue: 
A. Open your last used IMD file 
B. Rename it with your new venue name. 
C. Change the title line as well. 
D. Scan TV channels and change them in the TV station screen 
E. Select most stringent Options and select Recalculate all freqs 
F. If any are RED (cannot find a freq) lower the Option stringency and recalculate 

just that one freq. 
G. Continue with section I.D above. 
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III.  Long explanation: 
 

1. In IMD, use the TV data Wizard to find the TV stations for the address of your 
venue by entering the zip code.  Be sure that the data is current as downloaded 
from the FCC website via the IMD program.  Note that this information is not 
usually totally correct.  If you are not onsite this is the way to start, however if at 
the venue, I rely on on-site scanning and do not use the FCC database. (you can 
also get the lat/lon of the venue from Google Earth and use the FCC’s Media 
Database.) 
 
This is the IMD program screen with some frequencies already selected. 
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The TV stations wizard starts with the entry of the local zip code. 
 

 
 

2. Scan TV channels manually at your venue performance location for the most 
reliable information. 

a. On the R&S FSH3 spectrum analyzer I set the screen for a 10 mHz span 
window and Center frequency step size of 6 mHz.  This will shift the 
window 6 mHz each time you press the up arrow.  Select the center of 
channel 14, or 473 mHz or channel 21, 474 mHz in Europe with a step 
size of 8 mHz. Set RBW to 10kHz for better resolution, preamp on if 
available.  Inside metropolitan locations where there are a lot of RF 
sources, the preamp might give 
too much information.  Try it 
both ways, pre on for detail, pre 
off fo the most strong signals 
only. 
 
This is the start screen for a scan 
at channel 14.  It shows a high 
noise floor and several channels 
occupying the span already. 
 

 
 
b. Start the IMS software and select a 

new coordination file.  Save your 
file with the show name.  You might 
also enter the name within the file 
which will display it in printouts. 

 
c. Double click on the TV stations to 

open the checklist. 
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d. Step thru all TV channels using the up 
arrow key. 

i. A clear channel looks like this.  
Not much but a very low noice 
floor.  The display is set for a 
span of 10 mHz which will 
show an entire TV channel. 
 
 

 
 

ii. A DTV channel like this.  It 
resembles a box which is 6 mHz 
wide (here in the USA).  This 
shot shows other RF channels to 
the left and right as well. 

 
iii. An analog channel looks like 

this.  The large peak is the video 
carrier and the peak on the right 
is the audio carrier.  The small 
bump to the right of the video is 
the color carrier. 
 

iv. Weak DTV can also be a 
problem, however if it is very 
weak you might still be able to 
place frequencies there.  The effect will be noticeable by limiting the 
distance a frequency can be reliably received.  If your receive 
antennas are close to the transmitters you can live with a higher 
noise floor or a weak DTV station under it. 
 

e. As you find the channels, check the boxes in the IMD TV station list.   
 
There are separate tabs for analog and DTV.   
 
Selecting an analog station will tell the program to include the channel in 
its intermod calculations and will also allow channels to be inserted within 
the analog channel in the empty spaces.   
 
Labeling a channel as DTV totally excludes frequencies in that section 
except for the very small guard band between DTV stations.  Occasionally 
the IMD program will suggest a channel at the guard band between two 
DTV channels.  If the DTV is not too strong this might work. 
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f. Save your file 
 

3. Set the SA to monitor 
individual frequencies.  Set 
the span to 1 mHz to get a 
close up view of the area 
around a specific frequency.  
Each division will be 100 
kHz.  Typically you want the 
area to the left and right of a 
frequency clear for 300 kHz or 3 divisions.  A clear channel will look like the 
picture in III.2.d.i above.  Enter each frequency and look at their detail. 
 
 

 
 
 

An individual frequency with 
the transmitter on in a clear 
area will look like this: 

 
 

 
 
 
 
 
 

A frequency in a noisy or 
DTV area might look like 
this:  The interference to 
the left and right is very 
close but might be usable.  
Usually I like to see at 
least 200 or 300 kHz on 
each side.  This channel 
has 200 kHz below and 
about 175 kHz above.  Not 
the best situation but it 
might work over short 
distances. 
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This is what you would 
like it to look like before 
the transmitter is turned 
on and what you check 
for each time you pick a 
frequency. 
 
 
 
 
 

 
 

 
4. The Screen Tools>Options sets the kind of calculations the IMD program will 

use.  Using this screen you can set the program to be very stringent in 
intermodulation calculations or just check for frequency separation and do no 
intermod calculations.   
 
This setting, shown has a check 
mark in the ignore section for 
triple frequency IM which will 
ignore calculations which have 
intermod further than 40 mHz 
from the channel. This allows a 
better possibility to find 
frequencies. The selectivity of 
your receiver(s) front end(s)will 
dictate how much frequency 
separation will work.  
 
 
 
 

5. Start frequency selection with the wireless systems which are the least flexible 
because of  a limited number of adjustable frequencies or  if they are fixed 
frequency and can’t be adjusted, and work your way up to the systems with the 
most frequency selection options.  If you wait till other freqs are selected you may 
find out that none of the fixed or limited frequency systems can be selected 
without intermod issues.  When IMD does a global recalculation, this is the 
priority it uses too. 
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6. Next select all your transmit freqs.  It is most important to have intermodulation 
free transmit frequencies since often they are combined in an active antenna 
system.  Start with the Options set like above, for the most stringent calculations.   

 
7. After you have selected all your TX freqs, turn them all on.   One at a time, turn 

each transmitter off and look at the underlying RF of that frequency on the 
spectrum analyzer.  What you are looking for is intermod products.  If there are 
none it will look like a clear frequency as in figure III.2.D.i on page 5.  Another 
place to look is in the RF meter of the recievers.  This is called “War Gaming” 
and should be done with all freqs after you are done programming. 

 
8. Next, for wireless microphones 

work through your list using the 
pull down menus for each type 
of mic.  As you complete each 
selection, check each frequency 
on the SA and if it is clear, put a 
check mark next to it.  When 
you are finished, right click and 
move all selected to the left side 
to the Unassigned section (your 
finished list) and rename the 
section such as “MICS” 

 
9. The IMD program divides the frequency list into ZONES.  The difference 

between zones is that intermod is not calculated, just separation.  I find that many 
momentary frequencies, such as the transmits of an intercom BTR beltpack, are 
best assigned to a different zone.  This makes intermod calculations easier in your 
main zone. 

 
10. If it becomes hard to find frequencies (none show up when you test), the 

stringency of the options needs to be lowered.   
 

 
a. First to go is  testing the color carrier, then 3 TX 3rds, 

then 5th order.  
 
b. Next lower the distance between intermods down to 40 

mHz and later as low as 20 mHz.  Try to keep it no 
lower than twice the receiver front end filter window. 
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c. Setting all of the NTSC parameters to 0 helps to find more freqs also.  
This is OK since the US is Mostly DTV now. 
 

 
 

d. Lastly, consider checking weak DTV channels that you had avoided 
originally to see if frequencies work in them as well.  Your transmit 
distance will be limited but it is possible, particularly with shows which 
are inside and have the shielding of the building. 
 

11. Once you have your complete wireless plan, double click on each frequency and 
name each frequency such as mic 1, mic 2, ear 1, BTR T1, or BTR R2.  Naming 
each frequency will help if you need to select a replacement or are using this list 
as a touring system list for global frequency recalculation. 

 

 
 

12. Re selection of new frequencies is facilitated by the right click menu: 
 
Selecting a problem frequency and 
entering ctrl-f will do the group 
frequency list for that model.  This 
creates a list of possible replacement 
freqs on the right side of the screen.  
(Note that the normal pull down model 
menu does not reflect this search, only 
the list on the right).  If you cannot 
find a freq, lower the calculation stringency.  Force recalculate finds a frequency 
and immediately changes it on your list. 

 
13. Another way to force a new frequency calculation is to select the problem 

frequency and enter shift-ctrl-R.  This will find you a frequency which is different 
than the current one and put it in your list replacing the bad one.  I find it is useful 
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to add to the name of the bad frequency “was 555.123” listing what the frequency 
currently is.  That way when you do a forced recalculation it will end up like this: 

 

 
 

14. If you are on a tour and have moved to another venue, do the TV channel scan in 
a new copy of your file, renamed for the new location.  Set your stringency 
options to maximum and then select Tools>Recalculate all Frequencies.  This 
process is the same as we did above.  Fixed or limited frequency items are 
calculated first, then transmit frequencies and last RX freqs for frequency agile 
equipment.  Frequencies, which cannot be found, will be red.  Lower your 
Stringency and do individual forced recalculate on sections or individual 
frequencies. 

 
 

15. Your list can be customized by exporting to Excel.  Set the File>Report format to 
Master List.  Select preview to see it in a browser.  Now select ALL and copy 
then paste into Excel. 

 

.  
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After inserting in Excel, you can format and sort your list. 
 

 
 

IV.  Other IMD functions: 
1. Setting the TV standard.  In the 

options screen the tab TV 
standard allows the selection of 
most of the worlds TV 
standards.   

 
 

2. Edit user defined wireless models.  You can 
enter a strange wireless system which is not 
part of the standard pull down menu models.  
Although it is possible to start with a model 
and duplicate it before editing, this is not a 
good idea.  The tab labeled Presets lists all 
the possible settins of frequencies and is for 
those wireless which have limited random 
frequency possibilities.  This list is very hard 
to edit or delete. 
 
Best to start with a new entry for your 
custom wireless model. 
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3. The frequency graph shows the spectrum as you have entered it, yellow for DTV 

and blue lines for your frequencies.  This is just a graphical representation of the 
spectrum and not from a spectrum analyzer. 

 
 

 
 
You can zoom in on a section of the graph.  The graph is helpful to see where you 
still have available holes in the spectrum. 
 
 

 
 

A future improvement in IMD’s frequency graph will allow scans done with your 
SA to be imported and overlaid on the graph. 
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4. The menu option VIEW>List Of Models shows the database of wireless. 

 
 


